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DataMan 200 Systems

DataMan 200 Accessories

Z High-Speed 1DMax™ — IDQuick™ — IDMax™ —
f@‘\ﬂ Part Moving Best-In-Class High-Speed Difficult DPM
i Applications 1D Reading 2D Reading Reading
DataMan 200S*
(DMR-200S-xx) v v
DataMan 200QL** v v
(DMR-200QL-xx)
DataMan 200Q
(DMR-200Q-xx) v v v
DataMan 200X
v v v v

(DMR-200X-xx)

*S: Maximum decode rate of 5 codes / sec
**QL: 1D / Stacked symbols only

DataMan 200 Image Formation Options

Description Build Option Field Upgradeable
Manual Focus Option  User-settable focus
(DMR-200x-00) positions from 40 to v N/A
105mm.
Liquid Lens Option Software-controlled
(DMR-200x-01) adaptive autofocus. v Yes
C-Mount Option Allows use of
(DMR-200x-02) customer-supplied v No

C-mount lenses.

CD-ROM

(Setup Tool and Drivers) 63

(206-6400-330)

Quick Reference
Guide
(590-7111)

Mounting bracket
(DM100-
UBRK-000)

Pivot Mounting
Bracket
(DM100-PIVOTM-00)

AC Power over
Ethernet (PoE)
Injector
(CPS-AC-POE1A-xx)

Harsh Environment
Enclosure
(DM100-HENCL-00)

Red lens cover (ESD-
safe)
(DM100-RLC-000)

i
0

i
E B

.

Liguid Lens Module
(DM200-LLM-000)

Ethernet M12 to R145
cable
(CCB-84901-1003-xx)

I/0 cable
(CCB-M8I0-xx)

RS-232 cables
(CCB-M8X4-xx)

24\ Power over
Ethernet (PoE) DIN-
RAIL Mount Adapter
(CPS-24V-POE1)

Direct part mark
illumination kit
(DM100-DPML-000)

Clear lens cover (ESD-
safe)
(DM100-CLC-000)
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Reader Layout Setting the Focus Position

DataMan can operate in one of three distance ranges. To set the focus

Ethernet RS-232 I/0 | § e D position:
— -
1. Remove screws Disconnect
and lens cover. 5 DataMan from
power before
adjusting
. focus
COGNEX 1
i PID: DM::Z”I‘):]:‘ e 3
Al
(E Made In USA J
Mounting holes 2. Set focus position.
System (M3 X5)
e Yellow: Power Pushbutton

e Green: Ethernet connected
e Blink: Communication
(RS232, Ethernet or both)

e Push to read
e Push and hold 3
seconds to train

User e Use Setup Tool to
* Yellow: Untrained Erigra”;‘ adgmonal 3. Replace | <] Tighten screws in order
e Green: Trained utton tunctions : aﬁdp 22‘;\225 cover : shown. Maximum torque

e Blinking: Trigger for the cover screws is 9

N-cm (0.8 pound-inch).

Status

Green (pulse): Read N
Red (pulse): No read Illumination LEDs (2)
Red/Green (long pulse): Train Laser apertures (2)
or Optimize Focus result (aiming)
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Mounting the Reader Connecting the Reader

Mount the reader at Supply power to the reader using a Power over Ethernet (PoE) injector.
a slight angle (15°) Cognex recommends the following connection sequence:
to reduce reflections 1. Connect the PoE injector with the Ethernet installation (both sides of
and improve reader the patch cable).
performance.

2. Connect the power cord (AC 230V/110V) to the PoE injector.

w

. Connect the reader to the PoE injector.

Ethernet

Horizontal field of view for the DataMan 200 at working distances of 40mm,

65mm and 105mm (with and without optional liquid lens): RS-232  M12 to RJ45

PoE injector

. (optional) I
| 60 - ; :l:ln ]
40 - ""J 2
. To disconnect the reader:
| . 20 1. Disconnect the reader from the PoE injector.
e — ol s . 2. Disconnect the power cord from the PoE injector.
3. Disconnect the PoE injector from the Ethernet installation.
1 20 Using an RS-232 connection can be necessary to configure the reader
with parameters that allow it to communicate over your Ethernet
J 40 network.
Disconnect DataMan from power before removing or
60 changing cables.
mm 20 40 60 80 100 120 140 160 180

8 DataMan 200 Quick Reference Guide DataMan 200 Quick Reference Guide



Reading Distances

Supported range of reading distances for four code sizes (6, 8, 10, and 12 mil)
at each of the three focus positions (40mm, 65mm, and 105mm).

.

|
6 mil
8 mil
% 10 mil
<@
# 12 mil
<@
I B B e e I B B e e e
mm 20 40 60 80 100 120 140 160 180
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Install DataMan 200 Software

. Insert CD-ROM and follow the on-screen prompts.

. Connect the DataMan 200 to your PC.

A W N =

. Launch the Setup Tool and click Refresh.

The reader will appear under COM ports, Network devices, or both.

5. Select a COM port listing or Network devices listing and click Connect.

= COM parts
b COm1

. Check the DataMan Release Notes for a full list of system requirements.

..... el COM2 (Db 200) RS-232 connection

=] B Network devices

D200 _1339E0
© % Ethernet connection

“"DM200_" with last 6
characters of MAC address,

printed on back of the
reader

Troubleshooting an Ethernet Connection

Based on your network configuration, the Setup Tool may not be
able to communicate with the reader and it will not appear in the list
of Network devices.

First check your Ethernet connection with the reader and click
Refresh in the Setup Tool. Next, scan the Enable DHCP code in
the DM200 Configuration Codes document available from the Start
menu. This might allow the reader to acquire a suitable IP address
from a DHCP server on your subnet.

If the reader still does not appear, you can use either the Add
Device or Force Network Settings options in the Setup Tool.

If you know the IP address of the reader, use the Add Device
option. If you do not know the IP address, use the Force Network
Settings options. Either method should allow the DataMan 200
reader to appear in the list of Network devices so that you can
connect to it through the Setup Tool and your Ethernet connection.
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Start the Setup Tool

Connect the reader to the Setup Tool to Region of interest Context based help
configure it with the type of symbologies

it will decode as well as other parameters,

Trigger button Latest image

M200_Test (DM200) - DataMan Setup Tool o [ ]

such as the type of trigger it will use and the : frn iiz e B
format of the results it will generate. Advaneed x eRdE ey asa e 3
=7 Connectto Reader Train Code b ctimize Brghiness Show Al 2]
- Results Display Results Display
Connect to Reader i 5 Cbamerd S8 9 ot v e ok, vt

H - = Size (Region of | '@ How can I trigger the reader using the Setup
Establish a connection to the reader ¢ linage Sia (Ragien ot e
9 1 checked Transfer and display image’, Why

-% BurstMode Settings
don't I see an image?

Fi Symbology Sefings
Sy ay 9 @ vihen should T use the Train Code button?

4 Data Validation
Results Display 545! Data Formaling

=k Cammunication Settings

@ what is Live Display?

@ why does the symbol appear outined in
green but no dats appears in the Read Result
Histary list?

View results

@ why are some results in the results history list

-4 System Settings blue?

& Procass Monitar @) How can 1 increase the image transfer speed?

@ wihy can't T see all of my decoded data?

Li g ht an d Camera S etti ngs I¥ Transfer and display image: I Live Display Enabled @ Hon do Tyiew o the imeges tken i a
—Selected Read Resul burst trigger
. TR '@ How do I save an acquired image to a file?
Choose a trigger type and other acquisition = e B
ime Stamp: 139: FF:
parameters L o0 0o e sy
| Data | Time Stamp
System Settings
Configure input and output signals
o ol Clear Histary ]
[Time Stamp: 11:33356M  [Datar 0761941251127 Unlrained [ Connecled 4
Read history Train status Connection status
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Use the Setup Tool General Toolbar

Each reader can store its current set of run-time parameters to a configuration
(.cfg) file, which contains information such as the enabled symbologies and
how any output data should be formatted.

The same configuration file can be loaded onto multiple readers, as the file
does not contain identification information such as the IP address or device
name of the reader used to create it.

A reader can also generate a Cognex device configuration (.cdc) file, which
stores the set of run-time parameters plus any identification data, such as

the name of the device, its IP address, subnet mask, and so on. Cognex
recommends generating a device configuration file for each reader to allow you
to restore a reader to its operating state with minimal effort.

Use the File menu of the Setup Tool to manage .cfg and .cdc files:

Save Image Save the latest acquired image with the
.jpg or .bmp file format.

File Menu
Open Configuration Open a saved .cfg configuration file.
Save Configuration Create a .cfg configuration file of current run-

time parameters.

Print Configuration Code  Not supported on the DataMan 200.

Restore Device Load a saved device configuration .cdc file,
with run-time parameters plus device-specific
information for a particular DataMan 200.

Backup Device Create a device configuration .cdc file for a
specific reader.

Load Image Load an 8-bit uncompressed grey-scale .bmp or
.jpg image for analysis.

Save Burst Images Save the latest batch of burst images.
Use the Edit menu for standard Cut, Copy and Paste operations.

Use the View menu to view reader information (serial number, firmware
version, and so on) and to enable and disable various elements of the
Setup Tool, and the Tasks menu to switch between various Setup Tool
options.

Use the System menu to manage the current settings on the reader
and to upgrade the features it currently supports:
System Menu

Save Settings Save the current parameters to non-volatile
memory, which allows the reader to restore
these settings each time you reboot it.

Reset Configuration Reset all configuration parameters in RAM
(volatile memory) to the default settings.

Update Firmware Update the reader software.

Upload Feature Key Unlock additional features available in the

reader software if you have the right key.

VeriCode License Add VeriCode decoding by entering a license
string provided by Veritek. Ask your Cognex
sales representative for details.

Use the Help menu to display Setup Tool version information.
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DataMan 200 Triggering

Trigger the reader using any of the following methods:

Press the trigger button on the reader.
Send a pulse on the I/O cable:
Trigger + (blue), Trigger - (black)

Send a trigger command over the RS-
232 connection or Ethernet connection.

Click the Trigger button in the Setup
Tool:

F= DMZ00_133A05 (DM

Yiew Tas

DS

Press <CTRL>-T on the keyboard.

COGNEX

Trigger Modes

DataMan supports a variety of trigger modes:

Single: Acquires a single image and attempts to decode any symbol
it contains, or more than one symbol in cases where multicode is
enabled. The reader relies on an external trigger source.

Presentation: Repeatedly scans for a symbol and decodes it
whenever one is detected. The reader relies on an internal timing
mechanism to acquire images.

Manual (default): Begins acquiring images when you press the
trigger button on the reader, and continues acquiring images until a
symbol is found and decoded or you release the button.

Burst: Performs multiple image acquisitions based on an external
trigger and decodes any symbol appearing in a single image or
within a sequence of images, or multiple symbols in a single image
or within a sequence of images when multicode is enabled. You can
control the number of images within each burst and the interval
between image acquisitions.

Self: Similar to Presentation mode in that the reader perpetually
scans for symbols and decodes them each time one is detected.
Unlike Presentation mode, however, Self mode supports multicode
results and a decode attempt occurs with every image.

Continuous: Begins acquiring images based on a single external
trigger and continues to acquire images until a symbol is found
and decoded, or until multiple images containing as many codes
as specified in multicode mode are located, or until the trigger is
released.
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Training the Reader

Training your reader with the expected symbology can decrease the time Training Feedback
required to decode successive symbols. Train your reader by placing a code . - L
in front of it and doing one of the following: The middle LED on the reader glows green to indicate that it is currently

trained, or yellow to indicate that it is not trained.

e Press and hold the trigger button for a

o Connect the reader to the Setup Tool to
minimum of 3 seconds.

untrain it and allow it to recognize other
enabled symbologies.

Incremental Training for Multiple Symbologies

e Click and hold the trigger button in
the Setup Tool for a minimum of 3
seconds.

If you want to train the reader to recognize multiple symbologies, you
can present a single image showing all the desired symbologies and
perform the training procedure previously described.

If you cannot present a single image showing all the necessary
symbologies, you can enable incremental training on the Training tab
of the Symbology Settings pane:

e Click Train Code in the Results Display pane. Symbology Setlings

Genelall Multicode  Training I

Results Display

¥ Incremental Training

Train Code ] | Optimize Brightness |

With incremental training enabled, you can train the reader using
Training is supported for the Single, Burst, Continuous and Self trigger multiple images showing the symbologies you expect to decode. The
modes. reader will train each new symbology while retaining the existing
trained symbologies.
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C-Mount Option

The DataMan 200 is available with an optional C-mount in place of the
integrated lens assembly.

e The C-mount option is only available as a build option. You cannot remove
or install the C-mount yourself.

e Internal illumination and aiming are not available with the C-mount option.

e To prevent damage to your DataMan 200, do not leave the sensor exposed.
Make sure that either the supplied protective cover or a lens is in place at all
times.

e Not all C-mount lenses are compatible with the DataMan 200. The lenses
must meet the requirements listed below.

Threads must be no more than 4mm
deep.

Nothing must protrude past the end of
the threads.

Installing a C-Mount Lens

1 Remove and save the protective cover.

2

Install lens
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Liquid Lens EtherNet/IP Support

The DataMan 200 is available with a Liquid Lens option - an electronically The DataMan 200 supports EtherNet/IP™, a proven and complete
controllable variable focus system. industrial Ethernet network solution available for manufacturing
- . _ L . applications involving control, safety, synchronization, motion,
'Ir;hOeVil;:qu|<;rlér;sngffaenrsinr;pelgéehdaggstﬁeoef,ﬁseolgtvf\]lz;eibﬁirtlven autofocus with no configuration, and information. EtherNet/IP provides an extensive
9p P Y. range of messaging options and services for the transfer of data and
The Liquid Lens is available pre-installed or retrofitted to a standard model. I/O over Ethernet.
Contact your Cognex sales representative for more information. Enable EtherNet/IP using the Network Settings tab of the Setup
Tool:

Network Settings

Authenticationl Telnetl FTF'ImageI FTP Result Industrial Protecols

Ethermet/|F™
’7 I~ Enabled

For more information on using EtherNet/IP, read the DataMan
EtherNet/IP document available from the Start menu.
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I/0 Cable Acquisition Triggering

The 1/0 cable provides access to trigger and high-speed outputs. The acquisition trigger input on the reader is opto-isolated. To trigger
from an NPN (pull-down) type photo-detector or PLC output, connect

TRG+ to +24V and connect TRG- to the output of the detector. When
the output turns on, it pulls TRG- down to 0V, turning the opto-coupler

on.
To trigger from an PNP (pull-up) photo-detector or PLC output, connect
TRG+ to the output of the detector and connect TRG- to OV. When the
output turns on, it pulls TRG+ up to 24V, turning the opto-coupler ON.
5
Q +3.3V
TRG+O—AW T :
2.74K ! i
Pin # Signal Name Wire Color 1.0K i * A/ E
High Speed Out 0 Brown — i i
1 1
2 High Speed Out 1 White — TRG- O AN : Lok
- 2.T4K
3 Trigger + Blue — émK
i - —— i
4 Trigger Black B
5 Common Out Grey e

28V Max. Across input pins - Transition approx. 12V (Min).
Unused bare wires can be clipped short or tied back using a tie made of non-
conductive material.
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High-Speed Output Lines

The high-speed outputs can be used as either NPN

(pull-down) or PNP (pull-up)

lines. For NPN lines, the external load should be connected between the output
and the positive supply voltage (<28V). The outputs pull down to less than 3V
when ON, which causes current to flow through the load. When the outputs are

OFF, no current flows through the load.

Controller Opto-isolators

PTC
Fuse

- NPN Out

Out Common

Specification Description

Voltage 28V maximum through external load

Current 50mA maximum sink current

OFF state leakage current 100pA

External load resistance 240 Ohms to 10K Ohms

Each line rated at a maximum 50mA, protected against
over-current, short circuits and transients from switching
inductive loads. High current inductive loads require

external protection diode.

For PNP lines, the external load should be connected between the output
and the negative supply voltage (0V). When connected to a 24VDC
power supply, the outputs pull up greater than 21V when ON, and
current flows through the load. When the outputs are OFF, no current
flows through the load.

Controller Opto-isolators
N ———
I : 1 Out
| ! ™ Common
& |
: IS I
! i
' |
' ! . NPN Out
(R B | 100 Fuse
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High Speed Output Wiring

To connect to an NPN-compatible PLC input, connect Output 0 or Output 1

directly to the PLC input. When enabled, the output pulls the PLC input down to
less than 3V.

Common I High Speed Out 0
1T
NPN PLC
NPN Compatible Input
GND GND
24VDC 24VDC

To connect to a PNP-compatible PLC input, connect Output 0 or Output 1

directly to the PLC input. When enabled, the output pulls the PLC input up to
greater than 21V.

Common I High Speed Out 0
Pl dle ey
PNP PLC
PNP Compatible Input
GND T GND
24VDC © 24VDC

To connect the high-speed outputs to a relay, LED or similar load,
connect the negative side of the load to the output and the positive side
to +24V. When the output switches on, the negative side of the load

is pulled down to less than 3V, and 24 appears across the load. Use a

protection diode for a large inductive load, with the anode connected to
the output and the cathode connected to +24V.

Common High Speed Out 0
e ool
Load
GND (Coil, Relay...)
24VDC Not to exceed
100mA
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RS-232 Cable

The RS-232 cable provides an optional connection between the reader and

DataMan 200 Specifications

QO

Weight 759

Operating 0°C — 40°C (32°F — 104°F)
Temperature

Storage -10°C — 60°C (-14°F — 140°F)
Temperature

Maximum 95% (non-condensing)
Humidity

your PC.
TxD
2 _n_ —_
1 5 32
IN_l Qooao
(W e v
8
+3.3V
Nt O—AM
2.74K I I
[ 1
[ — 1
1.0K i T ;
1 '
1 1
i H
GND O AN .
(RS-232) 2.74k

§ 10K
=

28V Max. Across input pins - Transition approx. 12V (Min)

Environmental

IP65 (with cable or protection cap attached to all three con-
nectors)
None (C-mount option)

Vibration

EN61373 including IEC 60068-2-6,60068-2-64 6.4, and
60068-2-27

Codes

Data Matrix™ (IDMax: ECC 0, 50, 80, 100, 140, and 200;
IDQuick: ECC200)
Vericode (optional)
QR Code and microQR Code
UPC/EAN/JAN
Codabar, Interleaved 2 of 5, Code 39, Code 128, and Code
93, Pharma, Postal, RSS/CS, PDF 417, MicroPDF 417

Discrete 1/0
operating limits

Trigger, HS Output Max output current: 50 mA @ 28 VDC
0,1 Output load:

470 Q @ 24 VDC; 150 Q @ 12 VDC
Input voltage limits:- 28 VDC — +28

vDC
Input current: 4.2 mA @ 24 VDC; 2.0
mA@ 12 VDC

Power Supply PoE injector Class 1 or 48VDC

Requirements 2.0W Max LPS

32 DataMan 200 Quick Reference Guide

DataMan 200 Quick Reference Guide

33



Multi-Port Connections The cable must provide a DB-9 connector for each DataMan 200 serial
cable and a DB-9 connector for the PC serial port. Each DB-9 connector
must provide Tx Data, Rx Data, and ground. The Tx Data and Rx Data
pins on adjacent connectors must be connected to provide the multi-
port connection.

You can connect multiple DataMan 200 readers to a single PC (or other device
equipped with a serial port) using a multi-port connection.

A multi-port connection creates a daisy-chain of readers. Each reader receives
serial data from the previous reader and transmits it to the next reader. When
a reader transmits data, it is passed through each of the readers in the chain
between it and the PC.

The following diagram shows how to create a multi-port cable for a
3-reader system:

DataMan 200 DataMan 200 DataMan 200
e S
|
§ 2:Tx Data
... 3:RXData A g A T g A g
S ED IR R vdod

e ———-

BE P |

Because of the large number of possible configurations, Cognex does not
supply cabling for multi-port DataMan 200 connections. Instead, you must
construct your own cable that meets the requirements of your system 2:Rx Data

. . 3:Tx Data
configuration. 5:GND
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Configuring for Multi-Port Operation

You must connect the Setup tool to each DataMan 200 in turn and enable
multi-port operation. Click the Communication Settings task and check the
Enable Multi-Port (RS-232 Sharing) check box.

Enable Multi-Part [R5-232 Sharing)

There is no guaranteed delivery order when multiple readers transmit data
using a multi-port connection; read results may arrive at the PC in any order.
You can configure each DataMan 200 reader in a multi-port connection to add
identifying data to each read result. Your PC application can then determine
which reader produced a specific read result.

To do this, click on the Data Formatting task, check the Standard
Formatting Enabled box (for each symbology that you are using), and enter
text in the Leading Text field. (You can also add trailing text by entering text
in the Trailing Text field.)

Symbology Data Matrix v

Standard Formatting Enabled
Leading Text

Readerls|

Data
General | Validation | Cuality

<§up-sl!ig> S

Multi-Port Usage Notes

You can obtain the best results when using multi-port connections by
keeping the following usage guidelines in mind as you design your
system:

The maximum cable length between any two DataMan readers or
between the PC and any DataMan reader should be no greater than
15 meters.

There is no fixed limit to the number of DataMan readers that you
can connect to a single PC. Each reader introduces a delay of about
100 msec when it retransmits received serial data. If you have 5
readers, this means that there will be a 400 msec delay between the
time the first reader in the chain transmits data and the PC receives
it.

Each DataMan reader must receive a hardware trigger signal on its
Input O line. You can wire the input ports to a common trigger signal
or you can provide individual triggers for each reader.

If any reader in the multi-port chain loses power or becomes
disconnected, then no data from any other reader will be
transmitted.

If a DataMan is transmitting its own read result, it will buffer any
data received from another reader until it has finished its own data
transmission. If a DataMan reader is transmitting another reader’s
data, it will buffer its own data if it receives a trigger signal while it is
processing the other reader’s data.

If you use a single power supply for multiple readers, make sure that
the power supply can provide enough power for all of the readers.
You cannot connect a reader to the Setup Tool over RS-232 once
multiport is enabled. You must first scan the Disable Multi-Port code
from the Reader Configuration Codes, available from the Start menu.
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Compliance Notice

The DataMan 200 series meets or exceeds the
requirements of all applicable standards organi-
zations for safe operation. However, as with any
electrical equipment, the best way to ensure safe
operation is to operate them according to the
agency guidelines that follow. Please read these
guidelines carefully before using your device.

Regulator | Specification
USA FCC Part 15, Class A
FDA/CDRH Laser Notice No 50
Canada ICES-003
European EN55022:2006 +A1:2007, Class A
Community |EN55024:1998 +A1:2001 +A2:
2003
EN60950
EN60825-1
Australia C-TICK, AS/NZS CISPR 22 / EN
55022 for Class A Equipment
Japan 155022, Class A

FCC Class A Compliance Statement

S

This equipment has been tested and found to
comply with the limits for a Class A digital device,
pursuant to Part 15 of the FCC rules. These limits
are designed to provide reasonable protection
against harmful interference when the equip-
ment is operated in a commercial environment.
This equipment generates, uses, and can radiate

radio frequency energy and, if not installed and
used in accordance with the instructions, may
cause harmful interference to radio communica-
tions. Operation of this equipment in a residential
area is likely to cause harmful interference, in
which case the user will be required to correct the
interference at personal expense.

Canadian Compliance

This Class A digital apparatus complies with
Canadian ICES-003.

Cet appareil numérique de la classe A est con-
forme a la norme NMB-003 du Canada.

C-Tick Statement

V]

Conforms to AS/NZS CISPR 22/ EN 55022 for Class
A Equipment.

European Compliance

C€

The CE mark on the product indicates that the
system has been tested to and conforms to

the provisions noted within the 2004/108/EEC
Electromagnetic Compatibility Directive and the
2006/95/EEC Low Voltage Directive.

For further information please contact:
Cognex Corporation
One Vision Drive
Natick, MA 01760
USA

Cognex Corporation shall not be liable for use
of our product with equipment (i.e., power
supplies, personal computers, etc.) that is not
CE marked and does not comply with the Low
Voltage Directive.

Laser Safety Statement

Compliance with FDA performance standards
for laser products except for deviations
pursuant to Laser Notice No. 50, dated July
26,2001.

This device has been tested in accordance
with IEC60825-1 2nd ed., and has been certi-
fied to be under the limits of a Class 2 Laser
device.

Use of controls or adjustments or perfor-
mance of procedures other than those speci-
fied herein may result in hazardous radiation
exposure.

Mac: 00D024ABCDEF.
: P/N:821-0025-1R A
E sN:x12345678  cAUL)us
(e & LISTED
I.T.E. E246963
Power Rating: PoE Class 1 or
48V === 2.0W Max LPS Supplied F@
LASER LIGHT - DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT 650nm <1mWw
100mSec PULSE, REPETITION RATE 0.909 Hz

CLASSIFIED PER IEC 60825-1, Ed 2, 2007-03
CLASSIFIED PER AU/NZS 2211.1: 2004

Complies with FDA performance standards for
Iaser products except for deviations pursuant to
Laser Notice No. 50, dated June 24, 2007

UL and cUL Statement

@

UL and cUL listed: UL60950-1 1st ed. and CSA
C22.2 N0.60950-1 1st ed.

For European Community Users

Cognex complies with Directive 2002/96/EC

OF THE EUROPEAN PARLIAMENT AND OF THE
COUNCIL of 27 January 2003 on waste electrical
and electronic equipment (WEEE).

This product has required the extraction and use
of natural resources for its production. It may
contain hazardous substances that could impact
health and the environment, if not properly
disposed.

In order to avoid the dissemination of those sub-
stances in our environment and to diminish the
pressure on the natural resources, we encourage
you to use the appropriate take-back systems
for product disposal. Those systems will reuse or
recycle most of the materials of the product you
are disposing in a sound way.

B

The crossed out wheeled bin symbol informs
you that the product should not be disposed of
along with municipal waste and invites you to
use the appropriate separate take-back systems
for product disposal.
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If you need more information on the collection, reuse, and recycling systems, please contact your local or
regional waste administration.

2 LASER LIGHT, DO NOT STARE INTO BEAM: CLASS 2 LASER PRODUCT

FAILURE TO FOLLOW THESE INSTRUCTIONS MAY CAUSE SERIOUS
INJURY
You may also contact your supplier for more information on the environmental performance of this product.

e Use of controls or adjustments or performance of procedures other

Warnings and Notices than those specified herein may result in hazardous radiation
exposure.
CAUTION: This device requires the use of a PoE Class 1 or 48V DC LPS power e Do not attempt to service or repair this product -- return it to Cognex
A supply. for service.

e Do not permit anyone other than Cognex Corporation or Cognex-
authorized personnel to service, repair, or adjust this product.
0 NOTE: For product support, contact http:/support.cognex.com e Do not attempt to open or modify this device except as described in
this document.
e Do not direct or reflect laser light toward people or reflective objects.
CAUTION: IP protection is ensured only when all connectors are attached to cables Do not operate this device if it is damaged or if the covers or seals
or shielded by a sealing cap. are missing or damaged.

L]

This Laser Product is designated as Class 2 during all procedures of

operation.
Wavelength 650 nm
Laser Power for classification <1mw
Beam Diameter < 3mm at aperture
Divergence < 1.5 mrad

For assistance contact Cognex Corporation at http://support.cognex.com
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